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ET-PIC 24 WEB-V1
 

 

 ET-PIC 24 WEB-V1  เปนบอรดไมโครคอนโทรลเลอรในตระกูล PIC  ของบริษัท Microchip  โดยไดนําเอา
ไมโครคอนโทรลเลอรที่ประมวลผลขอมูลแบบ 16 บิต เบอร PIC24FJ128GA008 มาพัฒนาเปนบอรดใชงาน ซึ่ง
คุณสมบัติเดนของ PIC24FJ128GA008 ก็ คือ ความเร็ว และ ทรัพยากรตางๆ  ดังตอไปนี้ 
 

o หนวยประมวลผล  (CPU)  

• ความเร็วในการประมวลผล 16 MIPS  

• ฮารดแวรรองรับการคูณขอมูล 16 x 16 บิต โดยใชเวลาเพียง 1 ไซเคิลคําสั่ง  

• ฮารดแวรรองรับการหารขอมูล 32-bit x 16  บิต 

• C Compiler ถูกออกแบบใหมีความกระชับ Optimized Instruction Set 

o ระบบ (System) 

• แหลงกําเนิดสัญญาณนาฬิกาภายใน 31 kHz ถึง 8 MHz และ สูงสุดถึง  32 MHz โดยใช 4X PLL 

• มีวงจร  LDO Voltage Regulator อยูภายใน 

• รองรับ JTAG Boundary Scan และ  Flash Memory Program Support 

• มีระบบตรวจสอบสัญญาณนาฬิกา (Fail-Safe Clock Monitor – allows safe shutdown if clock fails) 

•  ระบบ  Watchdog Timer ที่ใชแหลงสัญญาณนาฬิกาแบบ RC oscillator ที่แยกจากสวนอ่ืนๆ 

• ทํางานที่แรงดันระดับ 2.0 ถึง 3.6 โวลต  

o การจัดการดานพลังงาน โดยเทคโนโลยีนาโนวัตต  (nanoWatt Power Managed Modes) 

• รองรับโหมดการทํางานแบบ  Run, Idle และ  Sleep modes  

• สามารถปรับเปลี่ยนโหมดการทํางานของสัญญาณนาฬิกาไดหลากหลายเพื่อประสิทธิภาพ และ ให

สอดคลองกับการดูแลจัดการในเรื่องของพลังงาน 

o คุณสมบัติทางดานสัญญาณอนาลอก (Analog Features) 

• โมดูลแปลงสัญญาณ Analog to Digital ความละเอียด 10-bit จํานวน 16 ชอง  ความเร็วในการแซมเปล

สัญญาณ  500 Kbit  ตอวินาที 

• โมดูลเปรียบเทียบแรงดันอนาลอก (Analog comparators) จํานวน  2 ชอง  
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o คุณสมบัติอื่นๆ ของ PIC24FJ128GA008 

• โมดูลการสื่อสาร UART จํานวน 2 ชอง บัฟเฟอรเปนแบบ FIFO ความลึก   4 ชั้น 

• โมดูลการสื่อสารแบบ SPI จํานวน 2 ชอง บัฟเฟอรเปนแบบ FIFO ความลึก   8 ชั้น 

• โมดูลการสื่อสารแบบ  I2C™ จํานวน 2 ชองรองรับทั้ง  Master และ  Slave Modes 

• โมดูล Timer ขนาด  16-bit จํานวน 5 โมดูล 

• โมดูล Capture , Compare / PWM  จํานวน 5 ชุด 

• ระบบฮารดแวร  RTCC, Real-Time Clock Calendar with Alarms ภายใน 

• ระบบการสื่อสารแบบขนาน PMP, Parallel Master Port, with 16 Address Lines, and 8/16-bit Data 

• หนวยความจําโปรแกรมแบบ Flash Memory ขนาด 128 KBytes 

• หนวยความจําขอมูล SRAM  ขนาด  8 Kbytes 

• I/O ports จํานวน 70 บิต 

 คุณสมบัติโดยท่ัวไปของบอรด  ET-PIC 24 WEB 

- ใชไมโครคอนโทรเลอร PIC24FJ128GA008 ขนาด 80 PIN  

- สัญญาณนาฬิกาคริสตอลออสซิลเลเตอรขนาด  8 MHz  (สามารถใช  x4PLL รันไดถึง 32 MHz)   

- I/O Port  ขนาด 10 PIN (จัดเรียงตามมาตรฐานของ อีทีที) จํานวน 9 พอรต 

- ชุดวงจรไดรเวอร  RS232 จํานวน 2 พอรต 

- พอรตสําหรับตอ LCD เรียงตามมาตรฐานของ อีทีที (ET-CLCD) จํานวน 1 พอรต 

- ขั้วตอสัญญาณดาวนโหลดโปรแกรมแบบ ICD2 และ สวิตชตัดตอสัญญาณ Run / Program 

- วงจร LED สําหรับใชทดลองเอาตพุตจํานวน 8 ชอง 

- วงจรสวิตช BUTTON สําหรับใชทดลองอินพุตจํานวน 4 ชอง 

- วงจรสรางแรงดัน 0-3.3V จากตัวตานทานปรับคาได สําหรับทดลองโมดูล A/D จํานวน 1 ชอง 

- พอรตเชื่อมตอกับหนวยความจํา EEPROM 25LCxxx จํานวน 1 ชอง  
- พอรตสําหรับเชื่อมตอกับโมดูลอินเตอรเน็ต ET-MINI ENC28J60  

- ชุดเรกูเรเตอรแบบสวิตชชิ่ง สําหรับแปลงสัญญาณไฟ DC Input ใหเปน 3.3 V 

- ขั้วตอแรงดันไฟ VCC และ GND 
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โครงสรางบอรด ET-PIC 24 WEB-V1 

 

 
 

อธิบายรายละเอียดตามหมายเลขไดดังตอไปนี้  
 

• หมายเลข  1  พอรตเชื่อมตอสัญญาณแบบ RS-232 จํานวน 2 พอรต มีวงจรการเชื่อมตอดังตอไปนี้ 
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1 2

3 4

5 6

7 8

9 10

RE0 RE1
RE2 RE3
RE4 RE5

+3.3V GND

PORTE-L

RE6 RE7

 

 

• หมายเลข  2    พอรต ET-LCD สําหรับเชื่อมตอกับจอแสดงผล LCD แบบตัวอักษร (Character LCD) โดยมี
การจัดวางขาสัญญาณตางๆ ดังตอไปนี้ 

 

 
 

• หมายเลข  3 , 4 , 5 , 6 , 7, 8 , 9, 10  และ 11    คือ พอรต I/O ของไมโครคอนโทรเลอร ที่ถูกออกแบบใหอยู
ในรูปแบบของพอรตมาตรฐาน 10-PIN ETT โดยในแตละพอรตมีการจัดเรียงสัญญาณดังตอไปนี้ 
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• หมายเลข 12   พอรตสัญญาณ I/O ขนาด 4 PIN ประกอบดวยสัญญาณ RE8,RE9,RF8 และ GND ดังตอไปนี้ 
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• หมายเลข 13  ขั้วตอสําหรับดาวนโหลดโปรแกรม เปนขั้วที่จัดเรียงตามมาตรฐานของ ICD2 รองรับเคร่ือง
โปรแกรมที่มีการเชื่อมตอตามมาตรฐานของ ICD2  เชน  PICKit2 , ICD2 และ เคร่ืองโปรแกรมของทาง
บริษัท อีทีที คือ ET-PGMPIC USB โดยกอนทําการโปรแกรมทุกคร้ังตองกดสวิตช MODE ใหมาอยูที่
ตําแหนง PGM ทุกคร้ัง เพื่อตัดตอขาสัญญาณมาเขากับเคร่ืองโปรแกรมจากภายนอก 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

• หมายเลข 14  สวิตชเลือกโหมด RUN และ PGM สวิตชน้ี เมื่อกดมาที่ตําแหนง PGM จะทําหนาที่ตัดตอ
ขาสัญญาณที่ใชในการโปรแกรมโคดขอมูลเขากับเคร่ืองโปรแกรม เพื่อทําการโปรแกรมขอมูลโปรแกรมที่
เราออกแบบ  และ เมื่อกดปลอยกลับมาที่ตําแหนง RUN ขาสัญญาณตางๆ จะกลับมาเปน I/O ใชงานไดตาม
ปรกติ 

 

 
 

• หมายเลข  15  ขั้วตอ DC-JACK สัญญาณไฟเลี้ยงบอรด รองรับแรงดันไฟจากภายนอก 9-12 VDC 

• หมายเลข  16  สวิตชรีเซต (Reset Switch) 
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RG6 (SCK) RG7(SO)
RG8 (SI) RD12 (CS)

NC NC

+3.3V GND

SPI MEMORY

NC NC

 

จัมเปอรสําหรับการเลือกการเชื่อมตอสัญญาณ RE8,RD15 และ RE9 ของ
ไมโครคอนโทรลเลอร กับขาสัญญาณ INT,RST และ WOL ของโมดูล 
ET-MINI ENC28J60  

   DIS = Disable คือ ไมเชื่อมตอสัญญาณ 

   EN  = Enable  คือ เชื่อมตอสัญญาณ 

• หมายเลข  17  ไอซีไมโครคอนโทรเลอร PIC24FJ128GA008  ขนาด 80-Pin 

• หมายเลข  18   หนวยความจํา EEPROM เบอร 25LCxxx ของ บริษัท Microchip เชื่อมตอแบบ SPI   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

• หมายเลข 19  ขั้วสัญญาณเชื่อมตอกับโมดูลสื่อสารอินเตอรเน็ต  ET-MINI ENC28J60 
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2-Pin CON
10K

SW-Button

+3.3V

2-Pin CON
10K

SW-Button

+3.3V

2-Pin CON
10K

SW-Button

+3.3V

2-Pin CON
10K

SW-Button

+3.3V

 

• หมายเลข 20   ชุด Test I/O LED ประกอบดวยหลอดไฟ LED จํานวน 8 ชุด ดังวงจรตอไปนี้ 
 

 

 

 

 

 

 

 

 

 

 

 

 

• หมายเลข 21  ชุดทดลองสัญญาณอินพุท จากสวิตช 4 ชุด สามารถสรางสัญญาณลอจิก 0 (0 โวลท) และ 
ลอจิก    1  ( +3.3 โวลท)  ดังวงจรตอไปนี้ 

 

 

 

 

 

 

 

 

• หมายเลข 22  ชุดทดลองแรงดันอนาลอก 4 ชุด สามารถปรับระดับแรงดันไฟไดตองแต 0 – 3.3 โวลท โดยมี
การตอวงจรดังตอไปนี้  

 

 

 

 

 

 

• หมายเลข 23   พื้นที่อเนกประสงค สําหรับตอวงจรเพิ่มเติม  
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โมดูล ET-MINI ENC28J60   

ET-MINI ENC28J60  เปนโมดูลที่ออกแบบมาเพื่อเปนตัวกลางในการเชื่อมตอระบบการสื่อสารระหวาง
ไมโครคอนโทรลเลอร กับโครงขาย Ethernet รองรับการทํางานของโปรโตคอล TCP/IP  โดยใชไอซี ENC28J60 ซึ่ง
เปนไอซี Ethernet Controller รองรับมาตรฐานการสื่อสาร IEEE 802.3 เชื่อมตอสัญญาณควบคุมผาน SPI Bus 

ความเร็วสูงสุด 10 Mb/s ในการพัฒนาโปรแกรมทางบริษัท Microchip จะสนับสนุนตัว Microchip TCP/IP Stack  

ซึ่งสามารถดาวนโหลด และ นําไปใชไดฟรีที่เว็ปไซตของ Microchip (www.microchip.com)  โดยคุณสมบัติคราวๆ 
ของ ENC28J60 จะเปนดังนี้ 
 

คุณสมบัติของ IC ENC28J60  

General: 

- IEEE 802.3 compatible Ethernet Controller 

- Integrated MAC and 10BASE-T PHY 

- 8 Kbyte Transmit/Receive Packet Dual Port Buffer SRAM 

- Programmable Automatic Retransmit on Collision 

- Programmable Padding and CRC Generation 

- Programmable Automatic Rejection of Erroneous Packets 

- SPI™ Interface with speeds up to 10 Mb/s 

- Supports Full and Half-Duplex modes 

Buffer: 

- Configurable transmit/receive buffer size 

- Hardware managed circular receive FIFO 

- Byte-wide random and sequential access 

- Internal DMA for fast memory copying 

- Hardware assisted IP checksum calculation 

PHY: 

- Wave shaping output filter 

- Loopback mode 

MAC: 

- Support for Unicast, Multicast and Broadcast packets 

- Programmable pattern matching of up to 64 bytes within packet at user defined offset 

- Programmable wake-up on multiple packet formats,including Magic Packet®, Unicast, Multicast, Broadcast, 

specific packet match or any packet 
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 การเชื่อมตอกับไมโครคอนโทรลเลอร สามารถทําไดโดยงาย โดยจะใชการเชื่อมตอแบบ SPI Bus ซึ่งจะใช
ขาสัญญาณเพียงไมกี่ขา และ ในสวนของระบบไฟ เนื่องจาก ENC28J60 เปนไอซีที่ทํางานที่แรงดัน 3 โวลท ดังนั้น
เพื่อใหสามารถใชงานไดกับไมโครคอนโทรลเลอรที่ทํางาน 5 โวลท ทางทีมงานจึงไดออกแบบ วงจรบัฟเฟอร 
สําหรับรองรับการเชื่อมตอระบบไฟ ระหวาง 3 โวลท กับ 5 โวลท เอาไวภายในบอรด ET-MINI ENC28J60  ซึ่ง
สามารถเลือกระบบไฟไดโดยการเลือก จัมพเปอร  5V/3V3   

 

 

 
 

 
 

รูปแสดงบล็อกไดอะแกรมการเชื่อมตอ ENC28J60  กับ ไมโครคอนโทรลเลอร 
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+5V

+3.3V

VDD

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

รูปแสดงโครงสรางของบอรด ETMINI  ENC28J60  
 

 จากรูป HD1 และ HD2  ออกแบบไวสําหรับการเชื่อมตอกับบอรด ET-PIC 24 WEB สวน HD3  ออกแบบ
สําหรับนําไปใชเชื่อมตอกับ ไมโครคอนโทรเลอรอ่ืนๆ โดยจะออกแบบในลักษณะของ ET-MINI ของ อีทีที 

 

 

 

คําเตือน : จะตองเลือกจัมเปอรให
ถูกตองตามการใชงานจริงไมเชนนั้น
อาจเกิดความเสียหายแกอุปกรณได
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ตาราง แสดงชื่อและหนาที่ขาสัญญาณตางๆ ของ  ENC28J60  

ชื่อขาสัญญาณ ชนิดของขาสัญญาณ หนาท่ีการทํางาน 

CS INPUT สัญญาณ Enable/Disable การเชื่อมตอ SPI Bus ของ ENC28J60 

        CS = 0  คือ Enable การเช่ือมตอสัญญาณ SPI ของ ENC28J60 

        CS = 1  คือ Disable การเช่ือมตอสัญญาณ SPI ของ ENC28J60 

SDO OUTPUT สัญญาณ Serial Data Output  

SDI INPUT สัญญาณ Serial Data Input 

SCK INPUT สัญญาณนาฬิกา  Serial Clock 

INT OUTPUT สัญญาณอินเตอรรัพท แอคทีฟ ลอจิก 0 

RST INPUT สัญญาณรีเซต แอคทีฟ ลอจิก 0 

WOL OUTPUT สัญญาณ Wake-up on LAN interrupt  แอคทีฟ ลอจิก 0 

CLKO OUTPUT สัญญาณ Programmable clock output 

LEDA OUTPUT แสดงสถานะของสัญญาณ  LINK 

LEDB OUTPUT แสดงสถานะของสัญญาณ   ACT 

 

    

ตารางแสดง สัญญาณการเชื่อมตอระหวางบอรด ENC28J60 กับ ET-PIC24 WEB 

ENC28J60 ET-PIC24WEB (PIC24FJ128GA008) 

CS RD14 

SDO RF8 

SDI RF7 

SCK RF6 

INT RE8 (เลือกโดยจัมเปอร) 
RST RD15 (เลือกโดยจัมเปอร) 
WOL RE9 (เลือกโดยจัมเปอร) 
CLKO - 

LEDA - 

LEDB - 
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สรุปการจัดสรรและใชงานทรัพยากรของบอรด ET-PIC24WEB V1.0 

 

 ตามปรกติแลว MCU เบอร PIC24FJ128GA008 ที่ใชกับบอรด ET-PIC24 WEB V1.0 น้ัน จะมีขาสัญญาณ

ใหใชงานไดโดยอิสระมากถึง 69 I/O แตจะมีขาสัญญาณบางสวน ถูกออกแบบและเชื่อมตอไวกับอุปกรณ I/O เปน

การเฉพาะไวเรียบรอยแลว ไมสามารถนํามาใชเปน I/O โดยทั่วไปได ซึ่งพอสรุปไดดังนี้ 

 

MCU Oscillator 

• RC12 ใชเปน OSC1 ตอกับ Crystal คา 8.00MHz สําหรับใชเปนสัญญาณนาฬิกาของ MCU 

• RC15 ใชเปน OSC2 ตอกับ Crystal คา 8.00MHz สําหรับใชเปนสัญญาณนาฬิกาของ MCU 

 

RTC Oscillator 

• RC13 ใชเปน OSC1 ตอกับ Crystal คา 32.768KHz สําหรับใชเปนสัญญาณนาฬิกาของ RTC 

• RC14 ใชเปน OSC2 ตอกับ Crystal คา 32.768KHz สําหรับใชเปนสัญญาณนาฬิกาของ RTC 

 

พอรตสื่อสารอนุกรม(UART) RS232-CH1 

• RF2 ใชเปนขา RXD สําหรับรับขอมูลจาก RS232 ชอง-1 

• RF3 ใชเปนขา TXD สําหรับสงขอมูลให RS232 ชอง-1 

 

พอรตสื่อสารอนุกรม(UART) RS232-CH2 

• RF4 ใชเปนขา RXD สําหรับรับขอมูลจาก RS232 ชอง-2 

• RF5 ใชเปนขา TXD สําหรับสงขอมูลให RS232 ชอง-2 

 

Ethernet Module (SPI-1) 

• RF6 ใชเปน SCK ในการเชื่อมตอกับ Ethernet Module (ET-MINI ENC28J60) 

• RF7 ใชเปน SDI ในการเชื่อมตอกับ Ethernet Module (ET-MINI ENC28J60) 

• RF8 ใชเปน SDO ในการเชื่อมตอกับ Ethernet Module (ET-MINI ENC28J60) 

• RD14 ใชเปน CS ในการเชื่อมตอกับ Ethernet Module (ET-MINI ENC28J60) 

• RE8 ใชเปน INT1 ในการเชื่อมตอกับ Ethernet Module (ET-MINI ENC28J60) โดยสามารถเลือกใชหรือไม

ใชได โดยการกําหนดที่ Jumper INT(EN/DS) ซึ่งตามปรกติเลือกเปน DS(Disable:ไมใชงาน) 

• RE9 ใชเปน WOL ในการเชื่อมตอกับ Ethernet Module (ET-MINI ENC28J60)โดยสามารถเลือกใชหรือไม

ใชได โดยการกําหนดที่ Jumper WOL(EN/DS) ซึ่งตามปรกติเลือกเปน DS(Disable:ไมใชงาน) 

• RD15 ใชเปน RST ในการเชื่อมตอกับ Ethernet Module (ET-MINI ENC28J60)โดยสามารถเลือกใชหรือไม

ใชได โดยการกําหนดที่ Jumper RST(EN/DS) ซึ่งตามปรกติเลือกเปน DS(Disable:ไมใชงาน) 
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SPI Memory Module (SPI-2) 

• RG6 ใชเปน SCK ในการเชื่อมตอกับ SPI Memory 

• RG7 ใชเปน SDI ในการเชื่อมตอกับ SPI Memory 

• RG8 ใชเปน SDO ในการเชื่อมตอกับ SPI Memory 

• RD12 ใชเปน CS ในการเชื่อมตอกับ SPI Memory 

 

Character LCD Display 

• RE0 ใชเปน LCD D4 ในการเชื่อมตอกับ Character LCD แบบ 4 Bit 

• RE1 ใชเปน LCD D5 ในการเชื่อมตอกับ Character LCD แบบ 4 Bit 

• RE2 ใชเปน LCD D6 ในการเชื่อมตอกับ Character LCD แบบ 4 Bit 

• RE3 ใชเปน LCD D7 ในการเชื่อมตอกับ Character LCD แบบ 4 Bit 

• RE4 ใชเปน LCD RS ในการเชื่อมตอกับ Character LCD แบบ 4 Bit 

• RE5 ใชเปน LCD RW ในการเชื่อมตอกับ Character LCD แบบ 4 Bit 

• RE6 ใชเปน LCD EN ในการเชื่อมตอกับ Character LCD แบบ 4 Bit 

 

LED[1..8] ในการทดลอง Web Server Control 

• RD0..RD7 ใชเปน Digital Output โดยตอกับ LED[1..8] 

 

SW[1..4] ในการทดลอง Web Server Control 

• RD8..RD11 ใชเปน Digital Input โดยตอกับ Switch[1..4] 

 

ADC Input ในการทดลอง Web Server Control 

• RB5(AN5) ใชเปน ADC0 ในการอานคา Input ของ Analog to Digital ขนาด 10 Bit โดยตอกับ VR1 
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แนะนําการใชงาน MPLAB C30 เบื้องตน 
 

 เปดโปรแกรม MPLAB IDE โดยคลิกที่ Start -> Microchip -> MPLAB IDE v7.61 -> MPLAB IDE หรือ 
ดับเบิลคลิกที่ ไอคอน MPLAB IDE หนา Desktop  ดังรูป 

 

 

 

 

 

 

 

 

 

 

 

 

 

2.  จะปรากฏหนาตางโปรแกรม MPLAB IDE v7.61 ดังรูป 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

หรือ ดับเบิลคลิกที่   
ไอคอน MPLAB IDE 
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 ทําการสรางโปรเจคโดยเลือกที่ Project -> Project Wizard.. 

 

 
 

 

 จะปรากฏหนาตาง Project Wizard ใหคลิกเลือก Next > เพื่อทําขั้นตอนตอไป 
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 เลือกอุปกรณในชอง Device: ใหตรงบอรด ในที่น้ีคือ PIC24FJ128GA008 จากนั้น คลิก Next >  
 

 
 

 เลือก คอมไพลเลอรที่ใช ในที่น้ีคือ  MPLAB C30 C Compiler (pic30-gcc.exe) จากนั้นคลิก Next > 
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 คลิก Browse ไปที่โฟลเดอรที่ตองการเก็บโปรเจค เชน สรางโฟลเดอรชื่อ PIC24_Start  ตามตัวอยาง แลว 
Browse.. เขาไปที่โฟลเดอรดังกลาว ทําการตั้งชื่อโปรเจ็ค ตัวอยางนี้จะตั้งชื่อวา Demo1 แลว Save 

 

 
 

 จะปรากฏหนาตางที่เราสามารถ Add หรือ Removeไฟลโคดตางๆ ในโปรเจ็ค กรณีที่มีไฟลโคดอยูแลว แต
ถาไมมี ก็ใหคลิก Next > เพื่อเขาสูขั้นตอนถัดไป  
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 จะปรากฏหนาตางสรุป คา พารามิเตอร ตางๆ ของโปรเจคที่เราไดสรางขึ้น ใหตรวจสอบความถูกตองแลว 
คลิก Finish  เพื่อจบขันตอนของ Project Wizard 

 

 
 

 โดยจะเขาสูหนาตางหลักของ MPLAB ใหเราคลิกที่ View -> Project  
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 จะปรากฏหนาตางแสดงโครงสรางไฟลของโปรเจ็คดังรูป 

 

 
 

 คลิกเลือก File -> New  เพื่อสรางไฟลซอรสโคด 
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 จะปรากฏหนาตางวางเปลาใหชื่อ Untitled ดังรูป  
 

 
 

 ใหเราเลือก File -> Save As…  เพื่อทําการบันทึกใหเปนไฟล  . C  

 

 
 

 ใหต้ังชื่อไฟลตามดวยนามสกุล  .C ในตัวอยางนี้คือ Demo1.C และ เลือก Save as type : เปน C Source Files 

(*.c,*.h) ดังรูปดานลาง 
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 เราจะไดไฟล Demo1.c เกิดขึ้นมา ใหทําการพิมพโคดโปรแกรมลงไปในไฟลดังกลาว ดังตัวอยางตอไปนี้ 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 จากนั้นทําการบันทึก  File -> Save 
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 ทําการ Add ไฟลซอรสโคดที่เราสรางขึ้นไปไวในโปรเจค โดยคลิกขวาที่  Source File แลวเลือก Add Files.. 

 

 
 

 จะปรากฏหนาตาง Add Files to Project ใหเราคลิกซายที่ไฟลซอรสโคด ในตัวอยางนี้คือ Demo1 จากนั้น
คลิก Open  
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 จะเห็นวาใน Source Files จะปรากฏไฟลชื่อ Demo1.c  

 

 
 

 จากนั้นทําการ Add  ไฟล Linker Scripts โดยคลิกขวาที่ Linker Scripts แลว เลือก Add Files.. 

 

 
 

 จะปรากฏหนาตาง Add Files to Project ใหคลิกเลือกไฟล p24FJ128GA008.gld ซึ่งจะอยูในโฟลเดอร ดังนี้ 
               C:\Program Files\Microchip\MPLAB C30\support\gld 
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 เมื่อเรียบรอยแลวเราจะเห็นไฟล p24FJ128GA008.gld ถูก Add เขามาใน Linker Scripts ดังรูป 

 

 
 

 

 ตอไปทําการคอมไพลโปรเจ็คโดยคลิกเลือก Project -> Build All  ดังรูป 
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 โดยจะมีการรายงานผลของของการคอมไพลในหนาตาง Output -> Build หากการคอมไพลสมบูรณจะมี
ขอความ BUILD SUCCEEDED ดังรูป 

 

 
 

 โดยจะปรากฏไฟล Demo1.Hex ในโฟลเดอรเดียวกับโปรเจคที่เราสรางขึ้นดังรูป 
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 การโปรแกรมซอรสโคด (Code Programming)  
 หลังจากที่ได Hex File แลวตอไปการโปรแกรมขอมูลโคดโปรแกรมลงไปในไมโครคอนโทรลเลอรของ
บอรด ET-PIC 24 WEB จะตองอาศัยเคร่ืองโปรแกรมจากภายนอก เชน ICD2 ,PICKit 2 หรือ เคร่ืองโปรแกรม ET-

PGM USB ของบริษัท อีทีที  ซึ่งสามารถทําไดโดยการตอสายสัญญาณโปรแกรมเขาไปที่ขั้วตอ ICD2 ดังรูปตอไปนี้ 
 

 

 
 

 
 

 กดสวิตช MODE มาที่ตําแหนง PGM 

 

 
 

 

ET-PGMPIC USB

ET- PIC24WEB
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 เปดโปรแกรม PICkit 2 Programmer 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 เลือก Device Family -> PIC24 
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 หากการเชื่อมตอเรียบรอย จะพบเบอร Device: เปน PIC24FJ128GA008 ดังรูป โดยในขั้นแรกใหทําการ 
Erase เพื่อทําการลบ Program Memory เกาออกกอน 

 

 
 

 จากนั้นทําการ Import ไฟล .HEX โดยคลิกที่ File -> Import  แลวเขาไปในโฟลเดอร PIC24_Start เลือกไฟล 
Demo1.Hex แลว Open 
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 จากนั้นจะปรากฏขอความ Hex file successfully imported  ใหเราคลิก Write เพื่อทําการโปรแกรม Hex code 

ลงไปในหนวยความจําของไมโครคอนโทรลเลอร 
 

 
 

 เมื่อการโปรแกรมเสร็จสมบูรณจะปรากฏขอความ Programming Successful. ดังรูป 
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 กดเลือกสวิตช MODE มาที่ตําแหนง Run 

 

 
 

 ตอฮารดแวรเพื่อทดสอบผลการทํางานของโปรแกรมดังนี้ 
 

PIC24FJ128GA008 LED 

RD0 LED1 

RD1 LED2 

RD2 LED3 

RD3 LED4 

RD4 LED5 

RD5 LED6 

RD6 LED7 

RD7 LED8 

 

 โดยจะเห็นหลอดไฟ LED ติดทีละดวงเริ่มจาก LED1 ไปจนถึง LED 8 
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ตัวอยางการทดสอบการทํางานของ ET-PIC 24 WEB-V1 
 

 

ความตองการทางดานฮารดแวร (Hardware Requirements)   

อุปกรณที่ใช 
- บอรดไมโครคอนโทรลเลอร  ET-PIC24WEB –V1 

- โมดูล ET-MINI ENC28J60 

- สายเชื่อมตอวงจร อยางนอย 13 เสน 

- จอแสดงผล  LCD  ขนาด 16 ตัวอักษร 2 บรรทัด 

- โมดูล EEPROM 25LC256 

- เคร่ืองโปรแกรม PIC รุน ET-PGMPIC USB พรอมสายเชื่อมตอ USB 

- แหลงจายไฟสําหรับบอรด ET-PIC24WEB-V1  (7-12V/850mA) 

- เคร่ืองคอมพิวเตอร ซึ่งมีพอรตเชื่อมตอ Ethernet LAN 

- สายเคเบิลของระบบแลนด ซึ่งมีอยูสองกรณี คือ  
• กรณีที่ 1 คือ การเชื่อมตอเขากับคอมพิวเตอรโดยตรง สาย LAN จะตองเขาสายแบบ Cross 

 

 

 

 

 

 

 

 

 

• กรณีที่ 2 คือ การเชื่อมตอผาน Hub ของเคร่ืองคอมพิวเตอร Server จะตองเขาสายแบบ Direct 
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ความตองการทางดานซอรฟแวร (Software Requirements)   

- ติดต้ังโปรแกรม MPLAB IDE v7.61 (เวอรชันลาสุด ณ ปจจุบัน กรกฎาคม 2550)  

- โปรแกรมคอมไพลเลอร C30  เวอรชัน 3.01 Student Edition 

- โปรแกรม  TCPIPStack 4.02  (เวอรชันลาสุด ณ ปจจุบัน กรกฎาคม 2550) 

- โปรแกรม รับสงขอมูลอนุกรม RS232 เชน  PROCOMM หรือ HyperTerminal ของวินโดว  
- โปรแกรม Internet Explorer  หรือ โปรแกรมที่เปดเวปเพจทั่วไป 

 

***  ใหทําการติดต้ังโปรแกรมเหลานี้ใหเรียบรอย 
 

ข้ันตอนการทดลอง 

1. ตอวงจรใหเรียบรอยดังนี้ 
 

 
 

 

รูปแสดงการเชื่อมตอสัญญาณตางๆ เพื่อทําการทดลอง 
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รูปแสดงบอรดทดลองหลังจากเชื่อมตอสัญญาณตางๆ 
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สัญญาณการเชื่อมตอ 

 สําหรับตัวอยาง Code Program ที่เปน Web Server Control ที่ทาง อีทีที จัดทําขึ้น เพื่อเปนแนวทาง และ

ตัวอยางการใชงาน เพื่อใหผูใชนําไปทดสอบการทํางาน และแกไขพัฒนาตามความตองการนั้น จะเปนการปรับปรุง

มาจากตัวอยาง Code ของ Microchips โดยทางอีทีที ไดนํา Source Code ของ TCP/IP Stack V4.02 จากทาง 

Microchips มาปรับปรุงแกไขใหสอดคลองกับ I/O ตางๆของบอรด ET-PIC24WEB V1.0 ซึ่งไดมีการปรับปรุงและ

แกไขดัดแปลง Code เฉพาะในสวนของ Webpage และ HTML สวนของการ Process I/O Function เทานั้น สวน

รายละเอียดการใชงานฟงกชั่นตางๆที่เปนของ TCP/IP Stack น้ันจะยึดตามตนฉบับของ Microchips เปนหลัก ซึ่งผูใช

สามารถศึกษารายละเอียดตางๆเกี่ยวกับการใชงาน ฟงกชั่นตางๆของ TCP/IP Stack ไดจากเอกสารที่ทาง Microchips 

จัดทําไวใหไดเอง โดยจะไมขอกลาวถึงในที่น้ีดวย 

โดยในตัวอยางทาง อีทีที จะจัดทําเปนลักษณะของการประยุกตใชงาน Web Server Control ขนาดเล็ก โดย

แสดงใหเห็นวิธีการรับสงคําสั่งจากหนา Webpage สําหรับควบคุมการทํางานของอุปกรณ I/O ตางๆ ที่อยูในบอรด 

ET-PIC24WEB V1.0 ทั้ง Digital Output (LED), Digital Input (SW), Analog Input (ADC) และ LCD Display โดย

ในการทดลองตามตัวอยางโปรแกรม ใหทําการเชื่อมตอสัญญาณ I/O ของ MCU กับวงจร I/O ตางๆตามรายละเอียด

ดังตอไปนี้ 

• Ethernet Module สําหรับใชในการเชื่อมตอกับ Ethernet LAN จะใชโมดูล ET-MINI ENC28J60 

ซึ่งสามารถรับสงขอมูลไดดวยความเร็วสูงสุด 10MB โดยฟงกชั่นในการเชื่อมตอจะใชสัญญาณ 

SPI1 ของ MCU โดยใชสัญญาณตางๆดังนี้ 

 RF6 ใชเปน SCK ในการเชื่อมตอกับ Ethernet Module (ET-MINI ENC28J60) 

 RF7 ใชเปน SDI ในการเชื่อมตอกับ Ethernet Module (ET-MINI ENC28J60) 

 RF8 ใชเปน SDO ในการเชื่อมตอกับ Ethernet Module (ET-MINI ENC28J60) 

 RD14 ใชเปน CS ในการเชื่อมตอกับ Ethernet Module (ET-MINI ENC28J60) 

 RE8 ใชเปน INT1 ในการเชื่อมตอกับ Ethernet Module (ET-MINI ENC28J60) ซึ่งใน

ตัวอยางนี้จะไมไดใชงานใหกําหนด Jumper INT(EN/DS) เปน DS(Disable:ไมใชงาน) 

 RE9 ใชเปน WOL ในการเชื่อมตอกับ Ethernet Module (ET-MINI ENC28J60) ซึ่งใน

ตัวอยางนี้จะไมไดใชงานใหกําหนด Jumper WOL(EN/DS) เปน DS(Disable:ไมใชงาน) 

 RD15 ใชเปน RST ในการเชื่อมตอกับ Ethernet Module (ET-MINI ENC28J60) ซึ่งใน

ตัวอยางนี้จะไมไดใชงานใหกําหนด Jumper RST(EN/DS) เปน DS(Disable:ไมใชงาน) 

• SPI Memory Module สําหรับใชเก็บ Webpage File และ CGI Scrip ตางๆ จะใชโมดูล 25LC256 

โดยฟงกชั่นการเชื่อมตอจะใชสัญญาณ SPI2 ของ MCU โดยใชสัญญาณตางๆดังนี้ 

 RG6 ใชเปน SCK ในการเชื่อมตอกับ SPI Memory 

 RG7 ใชเปน SDI ในการเชื่อมตอกับ SPI Memory 

 RG8 ใชเปน SDO ในการเชื่อมตอกับ SPI Memory 

 RD12 ใชเปน CS ในการเชื่อมตอกับ SPI Memory 
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• I/O Control Signal สําหรับใชควบคุมการทํางานและรับคา Input มาแสดงผลที่หนา Webpage 

โดยจะมีอยูดวยกัน 4 กลุม คือ 

  8 Bit Digital Output โดยใช LED เปนตัวแสดงสถานะของการทํางาน 

 4 Bit Digital Input โดยใช Push-Button Switch เปน Input 

 1 ชอง Analog Input ขนาด 10 Bit โดยใชตัวตานทานปรับคาไดเปน Input 

 Character Display LCD 16x2 สําหรับแสดงผลขอความตางๆ 
 

PIC24FJ128GA008 LED 

RD0 LED1 

RD1 LED2 

RD2 LED3 

RD3 LED4 

RD4 LED5 

RD5 LED6 

RD6 LED7 

RD7 LED8 
 

PIC24FJ128GA008 SW 

RD8 SW1 

RD9 SW2 

RD10 SW3 

RD11 SW4 
 

PIC24FJ128GA008 VR1 (0-3V3) 

RB5 VR1 

 

PIC24FJ128GA008 LCD 

RE0 D4 

RE1 D5 

RE2 D6 

RE3 D7 

RE4 RS 

RE5 RW 

RE6 EN 

 



ตัวอยางการทดลอง ET-PIC24 WEB-V1 

 
-6-

การกําหนดคา Configuration ใหบอรด ET-PIC24WEB V1.0 

 ตามปรกติแลวคา Configuration ตางๆของบอรด จะถูกกําหนดไวแลวในสวนของ Source Code ไมวาจะ

เปนคา IP Address, DHCP Name หรืออ่ืนๆ ซึ่งคา Configuration ตามคา Default ที่กําหนดไวภายใน Code น้ันตาม

ตัวอยางที่ทาง อีทีที จัดทําขึ้นจะเปนดังนี้ 

 Device IP Address คือ 192.168.1.200 

 Gateway IP Address คือ 192.168.1.255 

 Subnet mask คือ 255.255.255.0 

 DNS Server IP Address คือ 192.168.1.255 

 DCHP Protocol = Enable ,DHCP name = PIC24WEB 

 

แตอยางไรก็ตามผูใชสามารถเขาไปแกไขคา Configuration ตางๆไดเอง โดยไมจําเปนตองกลับไปแกไขที่ 

Source Code ก็ได ซึ่งการแกไขจะกระทําผานพอรตสื่อสารอนุกรม RS232 ชอง 2 (RS232-CH2) โดยใชโปรแกรม

จําพวก Serial Terminal ตางๆ เชน Procomm หรือ Hyper Terminal ก็ได โดยใหสั่งเชื่อมตอดวยเงื่อนไขดังนี้ 
 

Baudrate = 19200BPS, Data Bit = 8 Bit, Parity Bit = None, Stop Bit = 1 Bit, Flow Control = None 
 

ซึ่งหลังจากทําการเปดโปรแกรม Hyper Terminal และกําหนดการเชื่อมตอเรียบรอยแลว พรอมกับตอ

สายสัญญาณจาก RS232-CH2 ของบอรด ET-PIC24WEB V1.0 กับ Comport PC เปนที่เรียบรอยแลว ใหทําการกด

สวิตช SW1 ที่ตอกับ Port-RD8 คางไว พรอมกับกดสวิตช RESET ของบอรดแลวปลอย โดยที่ SW1 ยังกดคางอยู 

โดยโปรแกรมมอนิเตอรจะตรวจสอบวา มีการกด SW1 ในตอนเริ่มตนการทํางานหรือไม ซึ่งถาพบวามีการกดสวิตช

คางไวเปนเวลาอยางนอย 4 วินาที ก็จะเขาสูโหมดการ Setup Configuration ของบอรด แตถาไมพบการกดสวิตชใดๆ

ก็จะขามไปทํางานตามปรกติ โดยถามีการกด SW1 คางไวตอนเร่ิมตนการทํางาน(หลังรีเซ็ต) จะมีการสงขอความและ

เมนูคําสั่งกลับมาทางพอรต RS232-CH2 ซึ่งผูใชสามารถกดคีย เลือกตัวเลข ตามหัวขอตางๆ เพื่อทําการเปลี่ยนแปลง

แกไขคา Configuration ตางๆไดตามตองการ ดังตัวอยาง 
 

BUTTON0 held for more than 4 seconds.  EEPROM contents erased. 
 
Microchip TCP/IP Config Application (v4.02, Aug 22 2007) 
 
   1: Change serial number:               0 

   2: Change host name:                   PIC24WEB 
   3: Change static IP address:           192.168.1.200 
   4: Change static gateway address:      192.168.1.255 
   5: Change static subnet mask:          255.255.255.0 
   6: Change static primary DNS server:   192.168.1.255 
   7: Change static secondary DNS server: 192.168.1.255 
   8: Disable DHCP & IP Gleaning:         DHCP is currently enabled 
   9: Download MPFS image. 
   0: Save & Quit. 
Enter a menu choice: 
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192.168.1.200192.168.1.x 

ข้ันตอนการทดสอบ Web Server Control 

       1. ทําการติดต้ัง โมดูล และ เชื่อมตอสัญญาณใหกับอุปกรณ I/O ตางๆดังกลาวขางตนใหเรียบรอย ดังตัวอยาง 
 

 
รูปแสดงการเชื่อมตอฮารดแวร 

 

2. เชื่อมตอสาย LAN ระหวางบอรด เขากับระบบเครือขาย LAN โดย  กรณีที่เชื่อมตอผาน HUB จะตองใชสาย 
แบบ Direct และ กรณีที่เชื่อมตอเขากับการด LAN ของเคร่ืองคอมพิวเตอรจะตองใชสายแบบ Cross ดังรูป
ตอไปนี้ 

 

 

 

 

 

 

 

 

 

รูปแสดงการเชื่อมตอ ET-PIC24 WEB เขากับการด LAN ของคอมพิวเตอรใชสายแบบ Cross 
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ET-PIC24 WEB

HUB

Direct Line
Direct Line

Direct Line

192.168.1.200192.168.1.x 192.168.1.x 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

รูปแสดงการเชื่อมตอ ET-PIC24 WEB เขากับ HUB ของระบบ LAN ใชสายแบบ Direct 

 

3.  ทําการดาวนโหลดโปรแกรม (TCPIP Demo App-C30.hex)  

 

 
 

รูปแสดง การ Import ไฟล TCPIP Demo App-C30.hex ดวย PicKit 2 Programmer 
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รูปแสดงผลการโปรแกรมเสร็จ Programming Successful 
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4.    ทําการเซตคา TCP/IP ของคอมพิวเตอรให Subnet mask: และ IP address ใหเปนคลาสเดียวกันกับบอรด   ET-

PIC 24 WEB  ในตัวอยางนี้ IP ของบอรด คือ  192.168.1.200   เราจะตองเซต IP ของเคร่ืองคอมพิวเตอรใหเปน  
192.168.1.xxx  (xxx = 0  ถึง 255 แตตองไมซ้ํากับ 200 ซึ่งเปน IP ของบอรด)  สวน Subnet mask: ต้ังเปน 
255.255.255.255  ดังรูปตอไปนี้ 
 

 
 

รูปแสดงการตั้งคา TCP/IP ของคอมพิวเตอร 
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5. เปดโปรแกรม Command Prompt ซึ่งจะอยูในโฟลเดอร ET_PIC24WEB-> TCPIP Demo App ดังนี้ 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 เมื่อดับเบิลคลิก ICON ดังกลาวจะปรากฏหนาตาง Command Prompt ดังตอไปนี้ 
 

 
 

6. ลองทดสอบการเชื่อมตอโดยใชวิธีการ Ping  ไปที่หมายเลข IP ของบอรดในตัวอยางนี้ คือ 192.168.1.200  โดยให
พิมพคําสั่ง     ping  192.168.1.200  แลว Enter ดังรูปตอไปนี้   
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โดยผลจากการ Ping หากการเชื่อมตอสมบูรณ  ก็จะแสดงขอความ ดังนี้ 
 

 
 

แตถาหากการเชื่อมตอมีปญหาจะเปนดังนี้ 
 

 
 

7. เมื่อการเชื่อมตอสมบูรณเรียบรอยแลว ใหเปดโปรแกรม Internet Explorer แลวพิมพหมายเลข IP ของบอรดลงไป
ในชอง Address  ในตัวอยางนี้คือ 192.168.1.200  (หรือ พิมพ PIC24WEB) ซึ่งจะปรากฏหนาตาง เวปเพจดังแสดงใน
รูปตอไปนี้ 
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โดยจะมีสวนที่เราสามารถทดสอบการรับสงขอมูลระหวางหนาเวปเพจ กับ ตัวบอรด ET-PIC24 WEB ดังนี้ 
 
• Toggle LEDs  สามารถทําการทดสอบไดโดยคลิกที่ ปุม LED1 -  LED7 ซึ่งจะไปติด-ดับ ที่ LED บนบอรด 

• Write to LCD:  สามารถพิมพขอความแลวกดปุม Write สงไปโชวที่จอ LCD บนบอรดได 
• Status   จะแสดงผล อยู 3 สวน คือ  

- AN5(RB5)  แสดงผลจากการแปลงสัญญาณ Analog to Digital ที่ขา RB5 ซึ่งตออยูกับ VR 10K บนบอรด เมื่อ
ทําการปรับ VR1 คาก็จะ เปลี่ยนแปลงตาม 

- Buttons  RD11-RD8: เปนสถานะของการกดสวิตช SW1-SW4 ที่อยูบนบอรด ET-PIC24 WEB 

- LEDs  RD7-RD0:  เปนสถานะของพอรตที่ตอกับ LED บนบอรด ET-PIC24 WEB 
 

 

การคอมไพลเวปเพจ  
 ในเบื้องตนเราสามารถทําการแกไข รายละเอียดของหนาเวปเพจ จากตัวอยางไดโดยเขาไปในโฟลเดอร 
ET_PIC24WEB_Demo -> TCPIP Demo App -> Webpages  โดยอาจใชโปรแกรม Notepad  หรือ Notpad++ ในการ
แกไขโคด  
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 หลังจากทําการแกไขโคด html แลว จะตองทําการคอมไพลโคด html ใหเปนไฟล .bin เพื่อที่จะโหลดเขาไป
เก็บใน EEPROM  โดยทําไดดังนี้ 
 

 เปดหนาตาง Command Prompt  

 

 
 

 พิมพคําสั่ง  MPFS  Webpages  xxxx.bin     (xxxx = ชื่อไฟล .bin ที่เราตองการตั้งชื่อ)  ดังตัวอยางตอไปนี้
จะสรางไฟลชื่อ ET24WEB.bin   

 

 
 

 
 
 โดยโปรแกรมจะทําการคอมไพลไฟล html ในโฟลเดอรของ Webpages ใหเปนไฟล ET24WEB.bin  
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รูปแสดงผลการคอมไพลไฟล 
 

 โดยไฟล ET24WEB.bin ที่ถูกสรางจะอยูในโฟลเดอร TCPIP Demo App ดังตอไปนี้ 
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การดาวนโหลดเวปเพจลงไปในหนวยความจํา EEPROM 

หลังจากได ไฟล ET24WEB.bin มาแลว ตอไปให ดาวนโหลดไฟลดังกลาวนี้ไปเก็บไวใน EEPROM ของ
บอรด ET-PIC24WEB ซึ่งสามารถทําไดดังนี้ 

 

- เปดหนาตาง Command Prompt โดยดับเบิลคลิกที่ไอคอน Command Prompt 

 

 
 

        -  พิมพคําสั่ง FTP ตามดวยหมายเลข IP ของบอรด ET-PIC24WEB ดังตัวอยางนี้ คือ   FTP  192.168.1.200  แลว 
Enter โดยจะปรากฏขอความดังรูปดานลางนี้  
 

 

 

 

 

 

        -  ตอจากนั้นพิมพคําสั่ง  FTP แลว Enter จะปรากฏขอความใหใสพาสเวิรด โดยใหพิมพคําวา microchip ซึ่งเปน
รหัสที่ใชกับโคดตัวอยางนี้ 
 

 
 

- โดยจะปรากฏขอความ Logged in แสดงใหทราบวาไดเขาสูระบบเรียบรอยแลว 

 
 

 

 

 

- ใหพิมพคําสั่ง put  ตามดวย ชื่อไฟล .bin ในที่น้ีคือ  put  ET24WEB.bin  แลว Enter  ไฟล ET24WEB.bin จะ
ถูกถายโอนไปเก็บไวในหนวยความจํา EEPROM ดังรูปตอไปนี้ 

 

microchip
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- พิมพ คําสั่ง QUIT แลว Enter เพื่อออกจากระบบ FTP  

- เปดโปรแกรม Internet Explorer แลว พิมพหมายเลข IP คือ 192.168.1.200 ลงในชอง Address แลว Enter 

เพื่อทดสอบ 
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การพัฒนาและปรับปรุง Code Program 

 โดยรวมแลว Code ตางๆทั้งหมดที่อยูใน Project น้ีจะเปนสวนของ Protocol TCP/IP มาตรฐานทั้งหมด ที่ทาง 

Microchips ไดพัฒนาขึ้น ทําใหเราสามารถนํามาเรียกใชงานฟงกชั่นตางๆที่อยูในไฟลตางๆเหลานั้นไดทันที โดยไม

จําเปนตองไปแกไข Code ตางๆที่เปนสวนของ Protocol TCP/IP ใหเสียเวลา ซึ่ง Code ในสวนที่เราจําเปนตองแกไข

น้ัน จะเปนในสวนของ Application Layer ของ TCP/IP Stack เทานั้น ซึ่งใน Project น้ีไฟลตางๆที่เปนของ 

Application น้ันจะถูกแยกเก็บไวใน Folder ชื่อ “..\ET_PIC24WEB_Demo\TCPIP Demo App” 

 HardwareProfile.h เปนสวนของการกําหนดรายละเอียดของสัญญาณ I/O ตางๆ ที่จะใชในการเชื่อมตอกับ

อุปกรณภายนอก โดยตองกําหนดใหสอดคลองกับระบบฮารดแวรของบอรด ET-PIC24WEB V1.0 อัน

ไดแก Ethernet Driver (ET-MINI ENC28J60) ,SPI Memory Module(25LC256),LCD,LED,SW,ADC 

 TCPIPConfig.h เปนสวนของการกําหนดคา Default ตางๆเกี่ยวกับ TCP/IP Stack อันไดแก DHCP Name, IP 

Address ของบอรด,MAC Address ของบอรด 

 MainDemo.c เปนสวนของ Main Program ซึ่งจะมีการเรียกใช TCP/IP Stack และนําขอมูลตางๆที่ไดการ 

Stack มาประมวลผล และตัดสินใจ อันไดแกการแปลคําสั่งจาก CGI Scrip เพื่อนํารหัสคําสั่งไปสั่งงาน LED 

Output และ LCD Display รวมทั้งการอานคาสถานะของ I/O ตางๆเพื่อสงออกไป Refresh Status ของหนา 

Webpage เปนตน 

 Wabpage File ตางๆ เชน HTML และ CGI Scrip ใน Folder ชื่อ “Webpages” ซึ่งเปนสวนที่ผูใชสามารถทําการ

ดัดแปลงแกไขไดเองตามตองการ แตถามีการแกไขคาใน CGI Scrip ใหมีคาตางจากที่กําหนดไวแลว ผูใช

จําเปนตองเขาไปแกไข Code ที่อยูในไฟล “MainDemo.c” ใหสัมพันธและสอดคลองกันดวย 
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